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Welcome to the world of Aureas! Our company has specialized in
the development of astrological tools (books and software applica-
tions for general practice as well as for astrological research) in
French since 1987. Since then, our main products have also become
accessible in English and other languages. 
Aureas products have satisfied thousands of users in Europe and
overseas, and we believe that this program will fulfill your needs.
Please don’t hesitate to give us any feedback – feel free to make
suggestions regarding any improvements you would like to see
implemented.

ASTRO-PC is our main program. It has been developed over a pe-
riod of several years and is continually being improved and updated
to meet the needs of the international astrological community. It is
now available in several languages, including French, English, Span-
ish, and Italian. We attempt to include all widely used astrological
techniques. ASTRO-PC is available in two versions: a Basic version
and a Pro (professional) version – the difference between the two
versions is outlined on our web site at www.aureas.com

In addition, various INFOCIEL special application modules have
sprung out of the ASTRO-PC program and follow the same compati-
bility standards. Each INFOCIEL module contains selected functions
from ASTRO-PC, plus extras in some cases, designed to meet the
needs of specialist methods and techniques. Thus there is a module
for those using Traditional astrology, another for Karmic astrology,
another for Uranian astrology, and others for still other schools and
techniques. Many, but not all, of these, are available in English as
of 2013.

One key feature of the various specialized modules is that they auto-
matically work together if you choose to add other modules together
with them. You may start with one and add others according to your
needs in order to build a combined set that suits specialist needs and
work habits.
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This user’s guide, which is common to all Aureas astrological pro-
grams, will give you the essential information on the software you
have purchased. You will then find additional information in many
different places. See the chapter 3 for more information.

• ASTRO-PC and INFOCIEL modules offer several types of chart on the
screen. Attractive, functional graphics with modifiable chart parameters,
complete data input, a variety of detailed data tables, and quality printing
make these programs and modules some of the most desirable on the in-
ternational market. 

 • The learning time required for ASTRO-PC and INFOCIEL is only a couple
of hours, thanks to various help sources: on-screen lessons for new users
which can be printed out on paper, dynamic on-screen help, and a
printed user’s manual with tutorial, and optional technical assistance by
Internet or phone. 

• The AUREAS company has been actively involved in the European astro-
logical community for a number of years, has lengthy experience in digi-
tal astrology, and is now working with American astrologers to broaden
its scope. During its history, it has developed: • Minitel Servers • Astro-
logical Pocket Micro-computers • Programming on ASTROFLASH micro-
computers • Ephemerides and Astrological Tables (THE NEW INTERNA-
TIONAL EPHEMERIDES 1900-2050, THE COMPLETE EPHEMERIDES 1930-
2030, and others) • Publication of other astrological materials • Publica-
tion of French-language astrology books (see our French web site for
more information).

All these products, aimed at satisfying the needs of beginners and
professional astrologers, have contributed to Aureas’ reputation for
competence and reliability. Please do not hesitate to contact us for
further information on our entire line of products or visit our web
site.

AUREAS
12 Bis rue des Martyrs de Chateaubriant

78570 ANDRESY — France
Phone: 01 39 74 83 91 or 04 90 76 93 90

From Overseas: Tel: (France+) 1 39 74 83 91 or 4 90 76 93 90

Internet: www.aureas.com —  E-mail: aureas@aureas.com
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Important: Help and Technical Support

We encourage you to read this User’s Guide carefully. Take the time
to study it well, as it has been organized to ease your introduction to
our astrological programs and modules. Any time you invest in
studying it right now will save you much time later on. Take it with
you when riding in a vehicle or waiting for office appointments. It
gives you access to the information needed to maximize your astro-
logical potential in working with the program.
The most complete help guide for this software is available at any
time on your screen. Go to Chapter 3 to find how you can access
this detailed help.

Technical Support 
You can reach Technical Support in Europe or in the USA by e-
mail, for any problem relating to:

- Technical aspects of software installation.
- Technical aspects of software operation (use of com-

mands or setting options).

However, we must emphasize that Technical Support will not be
able to solve problems regarding:

- Printer drivers (check the printer’s user guide or contact
the printer manufacturer), or

- Use of the Windows environment (for which refer to your
Windows User’s Guide or contact Microsoft)

since these require specialized knowledge often available only from
the manufacturer of your printer or the continually changing corpus
of knowledge of Microsoft technicians.

Important: When you contact us for technical support, you must
provide us with your product Serial number (see back of this manual
or your invoice), and you need to be in front of your computer
screen.
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Using Windows
The Aureas astrological programs are programmed to function in the
standard Windows mode. Our programs are not guaranteed to func-
tion identically or fully with other configurations.

Phone/e-mail Support
Phone/e-mail support for ASTRO-PC is free for One Year from the
date of purchase.
Phone/e-mail support for INFOCIEL and SPECIAL URANIAN programs
is free for Six Months from the date of purchase.
After the initial free period Aureas offers Extended Annual Support
on a Flat Fee basis. Contact us if you are interested in this service.

IF YOU ARE NOT FAMILIAR WITH THE USE OF A COMPUTER
and its technical terms, first read the Glossary in chapter 3.
English-language users should note that extensive on-screen help
(under the Help menu) covers nearly every question about the pro-
grams, and that those, in combination with other documentation
supplied to you, will help you master the programs on your own,
feeling empowered and confident as a technically-competent as-
trologer.
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INSTALLATION & OPERATION
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1.1.   SERIAL NUMBER & SOFTWARE PROTECTION

SERIAL NUMBER:

We reference and verify the program that you have purchased by
means of a Serial Number. 
If you downloaded the program and the user’s guide directly from
our website, you received after your purchase an email stating your
serial number. In this case, write it down on the manual that you
can print at home.
The serial number will be required when you install the program on
your hard drive and at any time you contact our Technical Support
Department.

SOFTWARE PROTECTION :
To avoid illegal copies and to be able to continue to offer you after-
sales service, our programs include security protection, either as:

1) Security code registered onto your hard drive. This number
sequence is the standard protection provided with our
software, including Special Uranian Astrology – or:

2) Protection with a USB key: This one allows you to use the
program on several computers. If you have an old USB sec-
urity key purchased with a previous version of our software,
the serial number of your program starts with 12019.

1) Security protection on the hard drive:
Each program is sold with one security protection code and is in-
tended for use on a single computer (single user version). After in-
stallation, once the security code is written onto your hard drive, you
will not need your CD-ROM or installation file for routine use, and
you can safely store it.
Note: If you use two computers (but no more), an installation on a second
PC is possible for an additional cost listed on our website.

If you change your computer or your hard drive later on, you will
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need to re-install a security protection code, as explained below.

Important notice:
As the security protection is copied onto your hard drive, note that it
may be destroyed by a computer crash, by reformatting your hard
drive, or by reinstalling Windows. You will then need to reinstall the
software and ask for a new security code. The same thing will hap-
pen if you change to a new computer.

How to reinstall or transfer the security:
1) First remove the security protection from your actual hard drive:

the procedure is explained §1.6. You will get a deinstallation
number that you will have to record and give us to pro-
ceed. 

2) Perform a new installation with your CD-Rom or downloaded file
(see §1.2) and send us the information stated in the yellow
window that will appear when you launch the program (Last and
First Name, Address, etc.). To this data, you will also have to give
us the deinstallation number given at point 1. We will then send
you a new activation code. Again, our e-mail address is
aureas@aureas.com

2) USB key:
Security protection by USB key allows you to use the program on
several computers. Note: This system is no longer available due to
frequent operating problems with Windows 10 and 11. The informa-
tion below is kept for our old customers who already have a key.
Each time you start up the program, the presence of the key will be
checked. If missing, a message will tell you to connect it (or you will
be able to start the program in Demo mode). The key is only
needed while you are starting up the program – as long as you don’t
quit/exit the program, you can remove the key and use the USB key
for another computer, or the USB port for another device. If you
have other USB ports unused, you can of course leave the Aureas
key connected permanently.
If you are using multiple computers, you will need to move the key

8  — Chapter 1: Installation



from one PC to another depending on your needs. Be careful to not
lose the USB key, which contains the license to operate your pro-
gram, as you should in this case redeem the entire program. 
Warning: the USB key must be inserted into your computer after
full installation of the program (see section 1.2) and not before.
Note that if you want to install the program on a Macintosh with a Windows
emulator (like Parallels Desktop, VMware, Boot Camp, etc.), the USB key
may not work correctly. In that case, you need to contact us for other means
of protection security required to operate your program.

1.2. INSTALLING THE PROGRAM 
If you already have an older Aureas astrological program and therefore are
making an update of your program, read first paragraph 1.4.

Version 12 programs work with Windows 11, 10, 8, 7, Vista and
XP-sp3 (not compatible with Windows "S mode" or ARM). You need
to have a basic understanding of Windows to install the Aureas pro-
gram properly. If you need to, refer to the Windows User’s Guide or
ask someone knowledgeable of computers to help you.
Important: Begin by closing all open programs. It is essential that
you install the program in an Administrator account (and not a lim-
ited user account). Also, unless you have an Aureas USB security key, the
software is usually only available in the Administrator account on which you
installed the program (single session). If you want to make the program ac-
cessible to all administrator users (multi-session), you must specify it during
installation (see below).

Some antivirus programs may cause problems during installation. In
that case, you will have to deactivate them temporarily or allow our
software to run. See your antivirus user’s guide for indicators. 
If you have already installed a demo version of our programs, it is recom-
mended that you deinstall it before proceeding with the version you have
purchased. 

Installation of the program:
• Note: During installation, you will be prompted to choose the language in

which you want to install the software. However, if you purchased a
program including interpretation texts in French, you must choose the
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same language when installing, otherwise the texts will not be available.

• If you downloaded the program on our website, double-click on
the SetupAstro12 file and go directly to step 2 below. If you own
an old USB security key, you need first to install its driver by
starting the SetupCD file. To do this, follow the instructions of
step 1 below.

• If you received the program by mail, insert the Aureas CD in the
CD-ROM drive. The installation program should start automati-
cally when the CD is inserted in the CD-ROM drive. If this is the
case, go to step 1. Otherwise continue the operation as indicated
here:

Start the Run function using the Win+R shortcut key combination.
(See section 1.7 if you don’t know where the Win key is on the key-
board). In the window that will be displayed, type (without spaces):

D:SETUPCD.EXE      (and then click OK)
(change the letter “D:” to the one assigned to your CD-ROM drive if it is
different from “D”; this may for example be the case when you have
more than one hard drive on your computer).

If this procedure does not work on your computer, here is an al-
ternate method:  

Windows 11, 10, 8, 7 or Vista : start Windows Explorer using the
Win+E shortcut key combination. In the windows that appears, click
on the left on the Computer or This PC choice, then double-click on
the icon of your CD-ROM drive (Aureas) located on the right, and
finally double-click on the file SetupCD.

Windows XP : double-click on the My Computer icon located on your
Desktop screen. In the resulting window, double-click on the icon
representing your CD-ROM drive (where your Aureas CD should be
loaded). After the double-click, the contents of your Aureas CD will
show.  Now double-click on the SetupCD file.

1) A first window will display, indicating that you must shut down all
other running programs before starting the installation of your
new program. Do so, and click Next to continue.

• A new screen allows you to select the program that you want to
install. Select Astrology and click Next to continue.

• The next step concerns the installation of the driver of the USB
key. If you have an old USB security key purchased with a previ-
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ous version of our software (see §1.1), click the “Install the driver”
option. If not, select “Continue without installing or uninstalling
the driver”. Click Next to continue. You may be required to click
Next one more time, before the program installation starts (de-
pending on the individual program setup).

2) In the first window called “Aureas v12”, click Next to continue.
The next window indicates on which disk and in which directory
the program will be installed. You can change it, but we recom-
mend that you use the directory selected by default to avoid later
confusion. (Note that if you later want to change the directory where
you installed the software, it is necessary to completely uninstall the pro-
gram as explained at §1.6, then reinstall in the new desired directory.)

• Click on the Next button to continue. An optional new window
called “Additional Tasks” allows you, if you bought our Astro-PC
Pro software, to install an expanded database of worldwide cities.
Check this option if you purchased Astro-PC Professional. Click
Next to continue, then click the Install button. (Note that if you down-
loaded your software from our website, and therefore did not receive a
CD, the installation of this database must be made separately, by down-
loading the SetupCities file on our website, as stated in the email with the
download links that you received after your purchase.)

• Wait to see a message on the screen that verifies successful instal-
lation of the program. In case you requested the installation of the ex-
panded city database, a last step will allow you to install “Aureas Cities”
(see above).

— If your have a USB security key, connect it now —
• A shortcut icon called Aureas v12 has automatically been created

on your Desktop screen. Now, you can start up your program by
doing a double-click on this program icon. Alternative (except with
Windows 8): Click the Start button at the bottom left of the screen,
select All Programs, or All apps, then click on the Aureas group,
then the Aureas v12 icon. 

— Preliminary activation of the program:
• When you launch the program for the first time, a message asks

you to enter your program’s Serial Number (see section 1.1).
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This number is made up of 5 digits, a dash, three letters, a dash,
and one letter. Enter the Serial Number as it is shown, without
spaces. After entering you serial number, the name of the
program that is going to be activated is displayed on the right.

• Important notice: if you have two or more Aureas astrological
programs in version 12, you have to install them at the same
time, entering the serial numbers one below the other (for more
information, see section 1.5).

• Installation in multi-user mode: if you created multiple user accounts on
your computer, you can request the program to be accessible for all
accounts (only Administrator accounts). For this, you have to check the
small box  located at the bottom right of this window, just above the
note on a yellow background.

• Click now on the OK button to continue. Note: if you don’t enter any
serial number and click on the Aureas Demo button, the program will be
launched in its demo version, which allows you to test the program with
one single Chart.

— User information:
When your program shows a window named « User Information »,
you are asked to input some information which we will explain next.
To enter the information and move around the various lines in the
input window, use the mouse or the keyboard (Tab key).
1) Last Name and First Name: Type your last and first names (min-

imum two characters, upper or lower case, but no accented let-
ters.) 

2) Address: You can type up to three lines of text, using the Enter
key to go to the next line. (Number, Street, City, Postal or Zip
Code, State or Province or County, Country)

Click OK to continue. If you have an old USB key security protection,
go directly to section 1.3 (the next part is only for those who have
security protection on the hard drive).

— Aureas Activation:
This new window recalls the information you have entered with two
additional pieces of information: System Info 1 and System Info 2.
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One more operation is needed to install security protection on your
hard drive: you need to contact us and communicate the informa-
tion listed in that window (Last and First Name, Address, Serial
Number and the System Info 1 and 2). From this we will generate
the User Code that you need to finish the installation. You can re-
quest your code: 

— By phone:
For quick installation, call us by phone, and we can do the final
steps of the installation together. We can be reached Tuesday
through Friday from 9:00 am to 12:00 am, and 2:00 pm to 5:00 pm
at +4 90 76 93 90 or +1 39 74 83 91 (France). Take into account
the time difference. Note for foreign customers: our Customer Ser-
vice Department can communicate only in English, French, Italian,
and Spanish at this time.

— By e-mail:
Otherwise, for example during the weekend, send us by e-mail your
request with the above mentioned data. Here is how to proceed:

When you are in the « Aureas Activation » window, click on
the “Email” button. This will automatically open your email pro-
gram and create a new message for us: you just have to send it.
If you have a problem with this procedure, or if you use an Internet
mail service like Gmail, Hotmail, etc. (webmail), use the Copy button of
the Activation window. Then go to your mail service, create a new mes-
sage with our email address (hotline@aureas.com) and use the Paste
function to copy the information of the Activation window in the mes-
sage you send to us.

If you have installed several Aureas astrological programs in ver-
sion 12, repeat the procedure as many times as necessary: an
activation window will appear for each program. Send us the in-
formation of each window.

Then, while you are waiting to receive your User Code, click on the
Demo button in the « Aureas Activation » window. The program
will be launched as a demo version and you will be able to discover
the various functions it has to offer. The Demo will ask you to select
the program you want to test: click on the name of the software you
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purchased. When you first start the demo, you will be asked to enter
the data of the chart you want to use. For more information, see our
website.  

— Entering the User Code:
To enter the activation code when you will receive it, start the pro-
gram to find again the « Aureas Activation » window. At the bot-
tom of this screen, the blue line “Unlock code” allows you to enter
your code.
Use the keyboard to type the 14 digits of your user code. Verify it
carefully and click the Activate button to the right: the security pro-
tection is installed on your hard disk and the program is launched in
full version. On the top of the screen, the words “Aureas Demo” will
replaced by the name of your program. From now on, the previous
setup windows will not appear again, unless you make a mistake
while typing your code, in which case the program will tell you to in-
put it again.
This unlock code changes with each new installation of the program,
so it is not necessary to write it down. If you purchased several Au-
reas astrological programs in version 12, repeat the activation
process for each program.

The installation of your program is finished. If you have had a prob-
lem so that installation was not carried out effectively, contact our
technical support service (hotline@aureas.com). 

1.3.    PROGRAM CONFIGURATION
Once the installation of your program has finished, you can put
away your installation CD or archive the files that you downloaded,
as you will need them again only if you have to re-install the pro-
gram. 
When you start up your astrological software for the first time, a
small window “Aureas Installation” may appear during decom-
pression of some files. A first screen allows to preconfigure the main
elements of the program interface. We advise you to click on the
“Automatic” choice, which will allow to select the parameters
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adapted to the software you have purchased. These choices can
then be modified as you wish in the Options menu, Interface precon-
figuration.
Depending on the interface you have chosen, you will then get a
screen of colored buttons (tiles) that allows to access in a more con-
venient way the functions of the software (if you use for instance a
touchscreen). We will not use it for now, so you can click on the
close button “X” in the upper right window, or reduce it with the “_”
box. See Lesson 12 of this manual if you want to disable this screen.
You can configure the program to show you tips and advice for use
each time you start the software. To do this, click on the Options
menu, select Interface preconfiguration and check the option line
“View the screen tips at startup”. You can disable this option later
by unchecking the same line.
We recommend that the first time you use your program you config-
ure it and customize it to fit your usual astrological criteria. Refer to
the various options like “Astrology School Settings” and the avail-
able choices in the Options menu. Check also the program’s Screen
Help (see Chapter 3). You can also download the latest update of
your program (see below) to make sure you have the most recent
version. We recommend to do it.

1.4. SOFTWARE UPDATES
For downloading free subsequent program updates, use the follow-
ing procedure (after making sure you have installed your program as
described in section 1.2):
– Inside your new astrological program, click on the Help menu, and
then select the option Upgrading program and summer time files.
– In the subsequent text window that displays, click on the Software
and DST files button.  
– You will get a window letting you download the update automati-
cally from our web site (file called “aureas12update”). In case of
problem, you can also manually download the update from our web
site www.aureas.com, Downloads / Updates topic.
We recommend that you implement this process 1 or 2 times per
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year in order to work with the most recent version of your program.
Note that the update for Daylight/Summer Time files is done auto-
matically at the same time than the program.

How do you copy your chart data from previous versions of Aureas
programs?
If you already have a previous version of an Aureas astrological pro-
gram on the same computer, you can copy your old chart files via
the following method:
– In your new program, click on the menu item Help and select Re-
store personal data. In the small window that appears, click above
on the “Restore personal data of previous versions” menu, and se-
lect the installed version of your old software. (Note that this menu is
only available if you have an older version already installed on the same
computer.)

– Then click on OK. A text window will ask you to indicate which files
you want to retrieve; check all files you desire.
– Then click on OK; the files you selected will be copied from the old
location to the new: Documents\Aureas12. You can now proceed to
deinstall the old program per the standard Windows de/uninstalla-
tion procedure (see section 1.6). 
If you install your version 12 on a different computer than where
your previous version was installed, you can transfer your options
and charts files using for example a USB flashdrive, and the Save
and Restore personal data functions of the Help menu of the
astrological software. See the on-screen help of these functions for
more information.

1.5. INSTALLATION OF MORE THAN ONE
PROGRAM

If you purchase several AUREAS astrological programs version 12
(for example, both ASTRO-PC and SPECIAL URANIAN ASTROLOGY),
their individual functions will merge automatically into a single pro-
gram after installation for more practical use. 
To insure that this occurs, you must install the various programs at
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the same time, indicating all the serial numbers, one below the
other, during installation. When you have entered the serial number
of your first program, type the other serial number. Click the OK but-
ton only when you have entered all your serial numbers.
If you install a second program at a later date, do the following: se-
lect the Help menu of the software, then click on the first line “Info
on...”. In the window that appears, the second yellow box indicates
the serial number of your current software: double-click on it, this
action will exit the program. Restart it: you will find again the input
window of the serial numbers where you can add to your new soft-
ware.
Note that all programs must be of the same version (version 12), otherwise
you will first have to make an upgrade of your older software. Contact us if
you have any doubts about how to proceed.

1.6. DEINSTALL & REINSTALL THE PROGRAM
Before you begin to deinstall/uninstall the program, it is important
that you make a backup copy of the files with your personal charts
and options, so that they are not lost. To do this, click on the Help
menu and select Save personal data. You can save your data to a
USB flashdrive or other storage device. After saving your personal
files, you can remove the security protection, as follows:

1)  Remove the security protection
Even if you have an old USB security key, we recommend that you
follow this procedure to eliminate all unused files. To do this, click
the Help menu in your astrological software and select the first line:
Info on... In the window that displays, click on the [Tools] menu in
the top left, and then select Remove program and security codes.
This quits the software automatically and displays a yellow window
titled « Aureas Tools ». (You can also access this window by going to
your Documents directory, then selecting the Aureas 12 folder, and by dou-
ble-clicking the Aureas Tools shortcut.)

The « Aureas Tools » shows you different choices, for example:
   Remove security:
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    [ ASTRO-PC Pro ]

   Uninstall the software
   Exit

The gray buttons that appear in the frame “Remove the Security
Protection” show the programs presently installed on your computer.
To remove protection, click on the name of your program (in the
above example,  “Astro-PC Pro”).
The program will ask you to confirm and will display a deinstalla-
tion number. Write it down, as you will need to send it to us when
you ask for a new User Code. If you have an old USB security key,
there is no deinstallation number, and you will only have a message
telling you to reinstall the protection later.
Remove the Security Protections of every one of your programs if
you have more than one installed, and close this window when fin-
ished (Exit button).

2)  Remove the program
After the above step, just click on the button “Uninstall the software”
of the Aureas Tools window.
At the end of this procedure, your astrological program will be
deleted from your hard drive, except for your personal files located
in the “Aureas12” directory of the “Documents” directory (or “My
Documents”). If you don’t want to keep these files, delete them
manually.
Another way to remove the software (if you use Windows 11, 10, 7, Vista or
XP): click the Start button and select Settings or Control Panel. With win-
dows 11 & 10, click the Apps option. With Windows 7 or Vista, select « Pro-
grams and features » if you are using the Classic view of the Control panel,
or click on the Uninstall a program option under the “Programs” category
with the usual view. If you are using Windows XP, double-click on the
choice Add/Remove programs. – Then, for all versions of windows, in the
list of programs that appears, click on the Aureas v12 icon, then on the
Uninstall (or Remove) button. 

If you installed the expanded city database (available with Astro-PC Pro
only), you can uninstall it by selecting the choice Aureas Cities.
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1.7. SPECIAL KEYS
The following remarks are directed mainly to the users who are not
familiar with the special keys on the keyboard.
• The Alt, Ctrl, and Shift keys are used in combination with

other keys, and are found on the lower right and left sides of the
space bar on most keyboards. Each of these keys must be held
down (like the shift key normally is) while pressing the other keys
to be combined with them. For example: with the combination
Ctrl+N, you must continue to hold down the Ctrl key while
you are pressing on the key letter N.

• When the User’s Guide asks that you enter F8, this means the
Function Key F8, (and not letter F followed by number 8). This
applies to the other Function Keys (F1 through F12).

• The frequently used Tab key is usually represented on the key-
boards by a key with two horizontal arrows, one pointing right
and one pointing left. It can be found on the upper left side of the
keyboard, next to letter Q.

• The Enter key is the largest key on most keyboards, on the right
side of the alphabetic keys above the Shift key. The Esc key
is the uppermost key at the left side of the keyboard. 

• The Win (Windows) key is located on the lower left side of the
space bar, between the Ctrl and Alt keys. It is frequently used
with Windows 8 as it allows for example to move from the Win-
dows 8 Start screen to the Desktop interface.

• When the User’s Guide mentions the Backspace key it refers to
the key used to erase the last character that was typed. This key
can be found above the Enter key at the right side of the key-
board. It is often represented by an arrow pointing left: .

• When the User’s Guide mentions the Arrow Keys, it refers to the
keys used to move the cursor right, left, up and down on the
screen. On most keyboards they are grouped to the right of the
standard keyboard key section, and represented by four arrows,
pointing up, down, right, and left: .
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Note on Aureas programs 
This user’s guide applies to all Aureas astrological programs, since
the structure of each is similar. 
After installing your program, you will find more specific information
on the program you have bought under main menu bar Help. If for
example you use our Special Uranian program, you will find the fol-
lowing options under Help:
Special Uranian Astrology Help Documentation provides you with

the information (in English and German) needed to use the ma-
jority of functions in the Special Uranian Program. It is suggested
that you print this documentation out on paper by using the
“Print” button at the bottom of text window. Studying it will
greatly simplify operation of the program.

Help menu – Training Lessons Special Uranian Astrology provides
you access to lessons for learning to use the specific functions of
the Uranian program. To learn how to use the lessons function,
after you have opened up the lessons and have them displayed
on the screen, press the F1 key. You may also print these out
onto paper, for careful and thorough study, which will greatly
simplify operating the program in the future.
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It is important to take the time to review these lessons, as they will
save you much, much time later on when trying to understand how
it operates.  These lessons are also included inside most programs.
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2.1. LAUNCHING THE PROGRAM
At the end of the installation, a shortcut “Aureas v12” for starting
the program is automatically created on your Desktop (as well as in
the Start menu with Windows 11, 10, 7, Vista and XP, or an additional tile in
the Windows 8 start screen). In the lessons covered in this chapter we
will assume that your program is located in the directory designated
automatically during installation and that the options are set to the
original default. If you need to reset the options to their original con-
figuration, use the program’s Options Menu. 

1) — To launch the program, simply double-click on the Aureas
v12 shortcut on your Desktop (if you use Windows 8, you can also
use the tile “Aureas” from the start screen).

— Another way (with Windows 11, 10, 7, Vista or XP): Click the
Start button, select if necessary the All Programs or All apps
choice, then the Aureas12 group, and click on the Aureas v12
program shortcut.

2) When starting the program, a home page is displayed. The soft-
ware waits for your instructions.

2.2. DISPLAY
When running the program, the program screen displayed is com-
posed of several parts, including:

1 - The menu bar (at the top of the screen)
2 - The tools window (on the left)
3 - The Chart Graphics window (and Welcome screen)
4 - The sidebands of functions (left and right)
5 - Various possible data windows

1 - The menu bar
Located at the very top of the screen, the menu bar organizes most
all the program functions by category. For instance, the Natal menu
contains the functions related to calculating and viewing a natal
chart.

2 - The Tools window
Located at the left of the screen, the Tools window allows you to
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easily and quickly implement modifications of charts and data al-
ready displayed, as well as display extra data tables. Take time to
carefully study it and experiment with the buttons, because it will
help you save time in the long run (see the screen help for further
details).

3 - The Chart Graphics window
When starting up the program, this window displays various symbols
along with your name, or a chart (depending on the options). The
program is waiting for you to choose a function from one of the
menus before displaying an astrological chart in its place. For in-
stance, you can display a natal chart by using the Natal menu, Natal
chart function, and by clicking on the OK button, after which your
software will display a chart in the graphic window.

4 - The sidebands 
The multicolored bar on the left provides access to the window of
function buttons (for example for touchscreens). The right bar allows
to display around the chart many buttons of the Tools window.

5 - The Data windows
By using, for example, the Tools window, you have access to a
number of data lists that will be displayed in additional windows.
You can display as many data windows as you wish, but they may
cover up other essential data. You can use the mouse to move these
windows around the screen as you choose. As soon as you want to
close a window, click the “X” box located on the top right corner of
the window (or press the Ctrl+F4 keys) — or, to go faster, and
keep only the tools window and the graphics window on the screen,
press the F12 key.

The graphics (chart) window as well as the data windows can be moved
anywhere on the screen. To do so, click on the title bar of the window to be
moved, keep the mouse button pressed down, and move the mouse to
where you want the window relocated. Then release the mouse button.
Windows can also be expanded or reduced by dragging the edges with your
mouse or clicking on the expand/reduce key in the middle of the 3 keys at
the upper right corner of each window.
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TUTORIAL

2.3. LESSON 1  —  DATA INPUT
Note that for the Special Uranian Program: special lessons de-
signed for that program and its special functions are available within
the software, via main menu: Help / Training Lessons Special Ura-
nian Astrology: and those should be used instead of this Tutorial.
They can be printed out on paper, using the print function on the
lesson screens.

Important notes before proceeding: In the following lessons, a
small number of the commands, menus or buttons may not be in the
particular program that you own. In that case, please ignore those
items and proceed onward. ALSO, if you are testing the Demo Ver-
sion and have not bought the full version, you are able to enter only
one natal chart, and you should therefore substitute the data for that
chart in this lesson, noting that the full atlas and database of time
zones/changes is not included in the demo version.

Two input modes are available: a full mode, for former users of our
programs, and a simplified format, more intuitive for new cus-
tomers. You can change from one mode to another by clicking on
the buttons Full data entry / Simplified format in the data input win-
dow. In these lessons, we will use the simplified mode. The same
lessons with the full data entry mode are available from the Help
menu of the software, selecting the Training Lessons choice.
If you are a former user of our software, you can discover the new
simplified input mode in these lessons, and then activate the full
data entry if you prefer.

• In this lesson, we will enter the data of an example chart. To call
up the data input window, at the upper left corner of the screen
click on the Files menu of the menu bar. The first function line,
Open (Chart data input), allows you to enter the chart data. Click
on this line to go to the data input window. Make sure you are in
the simplified input mode: this window has a yellow background.

24  — Chapter 2: Tutorial



If it does not, click on the Simplified format button on the right.
• By using the mouse, or the keyboard, and the Enter and Tab

keys, we will fill the input fields with the following example:
Natal chart EXAMPLE, born the 1st of May, 2010 at 13h30
(1:30pm) in New York.
In these lessons, we will pay attention primarily to the commands
we need to make our examples work. The data input is described
in more detail in the screen help file of the program (see chapter
3, Screen help).

• On the keyboard, the Tab key and the Shift+Tab key combi-
nation allow you to move to the different input fields
(Shift+Tab allows to go backward). If you prefer to use the
mouse, just click on the desired area to move the cursor.

• When you arrive in the data input window, you can see that it is
made of two identical sections: data of the Natal chart on the
left side, and data of the Level 2 chart (second chart for synas-
try or prognostic work) on the right. For the moment, we only are
going to use the left side. Click on the orange button New chart
located below the banner “Natal Chart (1st chart)”. The data of
the Natal chart are blanked and the cursor blinks in the input field
of the name (white area to the right of the Name button).
Name: Enter the name you want to give to your chart (EXAM-

PLE), then click on the Country button located below.
Country: When you click on this button, a list of countries and

regions will appear. Have a look on this list to become familiar
with how the states and countries are categorized and notated.
With the mouse, you can use the scroll bar to the right of the
window to find the correct section of the alphabet where the
country of birth is located. You can also type on the keyboard
the first letters of the country to access it directly: for example,
if you type “USA” (quickly), you will arrive directly to the first
country beginning with these letters. You can then select the
desired country by double-clicking on its name. A third way to
select the country is to use the search function located to the
right: type only some letters of its name in the input field and
click on the Search button. A new window will display the list of
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all the countries including the characters you typed. Just dou-
ble-click on the desired country.  
State or Region: If you select a country using several time
zones, such as the United States, an additional window will ap-
pear asking you to choose the state (or region, province, area,
etc.). Proceed like for the country. For our example, you will
have to select “USA NEW YORK”.

City: After selecting the country, the City button located below is
automatically activated and displays the list of cities available
for the selected country/state. Again, scroll through the different
choices to find the city you want, then double-click on its
name. You can also type the first letters of the city to access it
directly: by typing “New”, you will arrive directly to the cities
beginning with these letters. A final possibility is to use the
search box on the right: if you type “York” in this area and
click on the Search button, you will get all the cities including
these characters. Then double-click on the desired city. Once
you have selected the city, the cursor will move directly to the
input box date, and the software will automatically display its
latitude and longitude below the city name.
Selection of the city: depending on the selected country, if the number
of available cities is important (like for Spain), an intermediate window
will appear asking you to indicate the first letter of the city name. Click-
ing on a letter will display only the cities starting with that letter.

Date: Enter now the date of the Natal chart. You can type the
year, month, and the day of birth in the individual windows.
You will have to enter year-month-day, or month-day-year, or
day-year-month depending on your Windows parameters. You
may find it easier to use the arrows next to each window to in-
crease or decrease the numbers. If you type in the numbers,
follow each entry with the Tab key, to proceed to the next data
window. Use the mouse or the keyboard to go to each input
area. Note: do not hit “Enter” after individual entries, or the program
may think you have finished entering all data for the individual or
event. Use only the Tab key or mouse.

Hours should be entered in the standard international 24 hour
format, which very simply adds 12 hours to births after noon;
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this standard international professional and business practice
avoids confusion between AM and PM births. (The order of the
year, month, and date is reset via the “Regional Settings” options in
the Control Panel of your Windows operating program, and so re-
mains identical to the settings you have chosen for your Windows op-
erating system.)

Verify TZ+DST button: if you click on this button (TZ = Time
Zone, DST = Daylight Saving Time), the program will display be-
low the time change for the state of New York for the entered
date and displays the Universal Time of 17h30 (5:30 pm) and
the time difference from U.T. 

Gender: You have the option of entering the sex of the native
before completing the data entry: click M for male or F for fe-
male near the bottom of the window. The choice “?” is used for
companies, events, etc.

• We have now entered the essential data to calculate a chart.
Next, click the OK button located on the right of the data input
window. The Natal Chart displays with the pre-set default options
included with the program. Later, we’ll see how to change these
options. The chart data (converted to Universal Time) are always
recalled at the top of the graphics window, in the Tools window,
and at the edge of the chart display window (if this option is acti-
vated). (Remember that Level 2 data is only used for second or
supplementary charts, and can otherwise be ignored.)

• Notice that you can ask for on-screen help wherever you are in
the program. If you need help concerning a precise component of
your program, simply move the cursor to the item you have ques-
tions about (by using the Tab key, or the mouse and a click) and
then press F1: at that point, you’ll get the desired screen help
(see chapter 3 for further information). To close the help window
and come back to the program, simply press the Esc key.

2.4. LESSON 2  —  Data input: chart files
We recommend that you repeat Lesson 1 on how to enter chart
data by working with the data of a family member or friend, once
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you have the full program installed (noting that the demo version al-
lows you to enter only one natal chart). We will then save it in a
chart file. 
When using the simplified data entry mode, note that each time you
return to the chart data input window with the Files menu, the previ-
ous data is automatically blanked to allow you to introduce directly
a new chart. If you want to recall the previous chart data, click on
the button Restore last chart used, or type Ctrl+D on the keyboard.
You can also click on the little yellow button “X” located to the right
of the city input field, it will have the same effect. Note: You can dis-
able this mode by clicking on the Quick-set data menu and uncheck-
ing the line “Automatically erase the Natal chart data”.

Creating a new Chart File
After entering the information of the desired chart, click the Save
chart blue button at the top of the window, under the banner « Na-
tal Chart (1st chart) ».
The program will ask you in what file you want to save the data you
entered. By default, after installing the software, it will suggest the
file named “Personal”, but you can select any existing file (like “Cus-
tomers”), or create a new file by typing the name you want (Family,
Friends, etc.) in the input box of the file name. Then click on the
Save button: your chart will be saved in the selected file, and you
can, from now on, save as many charts in it as you want.
This file is referred to as the “active chart file” and its name is now
indicated above the chart name, to the right of the “Active file” text.
On the first line is displayed the disk and folder in which it is located,
such as “Documents\Aureas12\Aureas_gam”: that is to say the
Aureas_gam folder, located in the Aureas12 folder, which is in the
Documents directory. The second line shows the name of the file (eg
“Personal”) and its extension (.gam).
Whenever you click on the Name button in the Data Input window,
the list of charts contained within the active chart file will appear. To
recall the data for a saved chart, double-click on the name in the list,
and the data will automatically transfer to the data-input text boxes.
From now on, for the next charts you want to save in this file, just
click on the button OK + Save Natal located to the right. 
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The Save chart button is to be used only when you create a brand
new file, or when you want to save the chart in a file other than the
already active chart file. In this last case, if the file exist already,
double-click on its name in the list which appears and the chart will
be saved in this file.
We recommend, at the beginning, that you only use one single file
for your charts (for example “Personal”). Once you are familiar
with the program, you can create as many others as you choose.

Opening a chart file
If you want to recall the data of a chart in a file other than the active
chart file, use the Open chart green button at the top of the window,
under the banner « Natal Chart (1st chart) ».
The program will display a window with the existing chart files, in-
cluding personal chart files, plus famous personality chart files sup-
plied with the program for you study (Artists, Astrologers, Centenari-
ans, etc.).
To select the desired file, simply double-click on it, and it will be-
come the active chart file; and the program will automatically dis-
play the list of the charts you can select from. We will see a concrete
example of the famous personalities files in Lesson 5. 
If you selected a new chart file and want later to return to your pre-
vious file of personal charts, repeat the same procedure as above
(Open chart), and select your file again (Personal, or Customers, or
Family…).
Faster, if you’re using the Astro-PC program, you can right-click on the
Open chart button and select from the drop-down menu that shows the last
files you used.

2.5. LESSON 3  —  Beyond the birth chart
Once a chart is displayed on the screen, you can ask for other infor-
mation at the same time. To do so, use the command buttons of the
Tools window located on the left of the screen. 
If you are using our Astro-PC program, the Tools window to the left
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can be displayed in three different formats: either in a simplified
version or with a more complete and colorful appearance, offering a
classic mode and an advanced mode. You can switch between the 3
display options by clicking the button Format 1/2 (or Format 2/2) at
the bottom of the Tools window. In our examples, we will be refer-
ring to the simplified display. The other display options are de-
scribed in the Help window (see chapter 3). If you purchased Astro-
PC, you may consequently want to click on the Format 1/2 button to
follow this lesson. You can also switch from one display to another
using the Ctrl+1 (format 1/2), Ctrl+2 (format 2/2, classic mode)
and Ctrl+3 (format 2/2, advanced mode) keyboard keys.
There are three groups of commands in the main section of the
Tools window, each accessible by clicking on the 3 folder tabs called
Time, Pos. (Positions) and Asp. (Aspects) – or Conf. (Configura-
tion) with the S.U.P. To view the contents of each of these groups/
folders, simply click on the folder tab name, and you will see the
window contents change. Then, click on the desired button. You can
also move from one group to another using the Ctrl+4 (Time),
Ctrl+5 (Pos.) and Ctrl+6 (Asp./Conf.) keyboard keys.
Some of the command buttons listed below are followed in paren-
theses by the tab category they belong to. First, you must click the
appropriate tab, and then you will see the subcategories and individ-
ual functions.

For example, to get:
• Positions of the planets and houses: click the PHPos button (in the

Pos. group). Note: Underlined buttons like PHPos. are configurable but-
tons: when you click on them, you can select the information you want to
see in the data window. To obtain the data directly without going through
this intermediate configuration screen, simply right-click on these but-
tons.

• Details of Natal aspects: click the Natal button (Asp. group) or the
AspTable button (in the Pos. group) (*)

• Planet by planet aspects: click directly on the desired planet in the
chart windows, or click the up or down arrow under Plan. (Asp.
group) (*) (if this does not trigger the desired effect, refresh the Natal
chart display: menu item Natal - Natal Chart — or click on the Refresh
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button in the Tools window)

• Investigation of each aspect type: click the up or down arrow un-
der Asp. (Asp. group) (*)  

• Planetary longitudes in Minutes: click the Min. button (Pos. group)
• Degrees of longitude only:  click the Deg. button (Pos. group)
• Planetary Strengths/weightings: click the Streng. button (Pos.) (*)

(The three last buttons change the values directly on the chart)

Note:  
– The commands followed by (*) are not available in all the programs.
– To know the meaning of the other buttons on the Tools window, see the
on- screen help (refer to Chapter 3).
– To close the data windows opened after the use of some buttons like PH-
Pos., click the “X” box located at the top right corner of the window to be
closed, or press the F12 key. To see all the data in a window, you can use
scrollbars in the window margins or stretch the windows out by dragging the
window borders.
– To get the data tables in black and white or color, click the Options menu,
select Lists and Tables, and check the desired option line.
– For a general summary of all positions of the planets and houses, plane-
tary aspects and strengths, click on the Interpretation menu, select General
summary of positions, and click OK.

To print the chart:
• Using the menus:  Files menu, Print function + OK

• Using the keyboard:  Press the F8 key + OK

• To print the details of the positions: Click the PHPos or AspTable
button (Pos.) then press the F8 key and click OK.

Size of the printed chart:
Note that the size of charts printed on paper is set independently of
the size of charts displayed on the computer screen. The size of the
screen chart is changed via the menu item Options–Chart Graphics
(and in the S.U.P. via Options–Advanced Users). The size of the
printed chart is changed via the menu item Files–Print, then by
modifying the percentage stated in the area « Chart size ».

Zoom:
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If you cannot see the details of the chart well enough, and wish to
enlarge it on the screen, double click on the chart. It will then display
over the entire screen of your computer (and in this case, menus will
temporarily be invisible and unavailable). To return to the regular
display and menu options, double click on the window again with
the mouse, or click on the X at top right. To reduce the display,
drag the corner of the chart display window, and the chart size will
reduce or expand accordingly. Note that some program functions
are not available with full-screen chart display. With a touch screen,
you can also use the Zoom button (accessed by pressing the right
sidebar, see lesson 12), and then return to the normal display with
Ok, return to the bottom right.

Contextual menu :
You can also obtain other data or information relating to a chart by
using the right-side button on your mouse. With a Natal Chart al-
ready displayed on the screen, right-click on the Sun glyph (M) in
the chart, and a scroll-down window (or contextual menu) will ap-
pear. You can then choose from the choices offered by again click-
ing with the left button on your mouse. The Contextual Menu func-
tions whenever you click on a planet, zodiacal sign, house number,
or aspect line (on the glyph of the aspect). In addition, if you right-
click in the empty background-area of a chart, away from any sym-
bols or lines, yet another menu will provide you with further options,
data, or information. Note: the number of choices in the contextual
menus varies depending on which Aureas program you are using.

2.6. LESSON 4 — Access to the various menus
When the menu bar

Files Natal Comparisons Transits Returns Directions Interpretation
Special  Options  Help

is on the first line of the screen, you can access the various menus
by clicking on the titles (or by pressing Alt and the underlined letter
of the desired menu). Note: according to the individual program ver-
sion or module you have, the above order or content may differ.
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• For instance, to see the Natal menu functions, click on it once (or
press Alt+N). The Natal menu will then appear on the screen.

• Select now the Transits menu (go to the next lesson if this doesn’t
exist in your program). Click on the Transit Chart line and select
the “On 2 adjacent windows” choice and “Transit Chart & Transit
Chart” for the aspects. Then click OK and you will get the Transit
Chart next to the Natal Chart.
To get the Transits for the next day, simply click on the Future
button of the tools window (Time group), or type on the “+” key-
board key. Use the Past button, or the “-” key, to get the previ-
ous day (the Transits dates are automatically changed, as you
can see in the chart window).

• To get details on:
– The aspects of the Transits Chart: click the Chart button (Asp.
group) of the Tools window
– The aspects of the Natal Chart:  click the Natal button (Asp.)
– The aspects between these two charts: click Nat/DC or DC/Nat
(Asp.) (Nat=Natal, DC=Displayed Chart)
– The detail of the positions: click PHPos. (Pos.), or select the In-
terpretation menu, General summary of positions, check the
choices “Natal Chart” and “Transit Chart” on the left, then click
OK.
– The positions on the printer: press on F8 after the PHPos. but-
ton

• To get the aspects for a planet, you can also use the contextual
menu by clicking with the right mouse button on the planet sym-
bol (see previous lesson).

2.7. LESSON 5  —  In depth look at data input

Viewing a chart file
• After having selected the Open (Chart data input) line in the Files

menu, we are going to have a look at an example file which con-
cerns movie stars. Many charts of famous persons, classified by
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profession or function (politicians, scientists, religious figures, etc.)
are provided with your program. See the screen help for further
information.

• When arriving at the data input window, click on the button Open
chart located below the banner “Natal Chart (1st chart)”. A win-
dow listing the chart files present in the directory displays. With
the mouse, select the Cinema file in the list (the fastest way is to
double click on its name). 
Note: these files are located in the Aureas_gam folder of the Aureas12 di-
rectory, that you can find in the (My)Documents directory of your com-
puter. If you saved your personal files in another directory, you will have
to come back to the Aureas_gam folder to find the files of famous per-
sons (or simply double-click on the 1st gray line to the right of “Active
file”).

• After having selected a file, the program automatically activates
the Name command button. This button allows you to view a list
of the charts saved in the active charts file and to choose the de-
sired data.

• In the window listing the charts present in the Cinema file, select
the desired chart with the mouse or the arrow keys. We will, as
an example, select Catherine Deneuve’s chart. Press on the letter
D in order to go directly to the names beginning with that letter.
The file goes to the first name beginning with D:

DALLE Beatrice (19 12 1964)
...
DELUBAC Jacqueline (27 05 1907)
DENEUVE Catherine (22 10 1943)

• Use the mouse or the keyboard to select the line with DENEUVE
Catherine’s name. You can either double-click on its name, or
click once to select it and then click on the button OK, return.

• The data of the selected chart are displayed automatically in the
input window. Above DENEUVE Catherine’s name, you can see
that the active chart file is now Cinema.gam. Click on the OK but-
ton located on the right to quit the data input window. The natal
chart of Catherine Deneuve is displayed on the screen.

• Note: when you will want to go back to your usual personal chart
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file, all you need is to return in the data input window, click on
the Open chart button and select your file (Personal, Cus-
tomers…). Tip: with Astro-PC, you can also click on the Open
chart button with the right mouse button and select the desired
file in the list.

How to use the screen help
Note that you can use the F2 keyboard shortcut to access the data
input window more quickly. In this window, you can get various in-
formation about the input areas. 
• To get general help about data input, select the Help button lo-

cated on the right.
• To get specific help with the various data input boxes and func-

tions, move the cursor to the specific box or button, and then
press F1.

• To end and close the help window, press Esc or Alt+F4 (or
click top right on the “X” box). Later, we will deal with the partic-
ulars of the help screens.

Note: with the latest versions of Windows, the help screen is displayed
by default in a form less convenient to read and use. See Chapter 3 for
information on obtaining a more readable and practical interactive help.

2.8 LESSON 6  —  Chart Comparison
Note: Go to the next lesson if the “Comparisons” menu is not an option
available in your software.

• Now, we are going to see how to compare two charts. Once
again, we will use Catherine Deneuve’s chart (see previous les-
son) as an example and compare it to Yves Montand’s chart.

• First of all, press F2 (keyboard shortcut to access the data input
window) and click on the button Restore last chart used to recover
the data of the previous chart you worked with. If the displayed
data are not those of Catherine Deneuve’s, do again lesson 5 to
select her chart.

• Now, we are going to fill in the “Level 2 Chart” section, allowing
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us to enter a second chart data to do comparisons. For this, we
will use the right-hand data input window (the buttons and input
fields to the right of the Natal chart data buttons). 

• We are going to search for Yves Montand’s chart which is also in
the Cinema file. Since the active chart file for the “Level 2 Chart”
is not Cinema.gam, click on the Open chart button located below
the banner “Level 2 Chart (for prognosis or synastry)” and then
select the Cinema file as we did in the previous lesson.

• The window listing the charts in this file is automatically dis-
played. To select Yves Montand’s chart, press M to go directly to
the names beginning with this letter. With the mouse or the key-
board, go down the list and select the chart.

• Check the data displayed, and click next on the OK button of the
input window.

• Now, we are going to display the comparison between the two
charts. Click on the Comparisons menu and select the Synastry
function. Choose the “On 2 adjacent windows” line, select “2nd
Chart & 2nd Chart” for the aspects, and click OK.

• The two charts are displayed side by side. You can click Nat/DC
or DC/Nat of the Aspects (Asp.) group of the Tools window to get
the comparison aspects between the two charts. The Natal button
will give you the aspects of the Natal chart (Deneuve) and the
Chart button the aspects of the Level 2 Chart (Montand). Do not
forget that you can enlarge and reduce (zoom) the charts by click-
ing twice in the chart graphics window.

• For those who work with composite charts (midpoints between
two charts), select the Composite chart function of the same
Comparisons menu to get that chart.

• Note that when you display the comparison aspects between two charts,
the orbs are automatically reduced to avoid overloading the map. To in-
crease or decrease the number of aspects, click on the Options menu,
choose Aspects and orbs, and select the desired value for the percentage
of comparison between two charts (100% = many aspects, 50% = ap-
proximately two times less, etc.).
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2.9.  LESSON 7  —  Viewing a Solar Return
Note: Go to the next lesson if the Solar Return function is not available in
your software.

• When you wish to calculate Returns, Transits, Directions or other
secondary charts, you must first enter the date and place for
which the chart has to be calculated in the “Level 2 Chart” sec-
tion of the data input window. Let’s take an example and calcu-
late the Solar Return of Catherine Deneuve for 2011 in Paris,
France.

• Click on the Returns menu and select the Solar Return function.
The settings window that appears recalls the data of the Natal
chart (October 22, 1943) and those that are going to be used for
the Solar return. As we just made in the previous lesson a com-
parison with Yves Montand’s chart, the data shown for Level 2
are not the ones we want. To change them, click on the Change
chart data button located top right of this window.

• This button allows you to access the data input specific to the
function. That means that you will be requested to input only the
information necessary to calculate the chart you selected. For a
S.R., the program only needs the location and the desired year:
the right side of the data input (level 2 chart) will therefore ask
you to enter only this information.

• Tip: to introduce the data of a chart, you can therefore either use
the main data input window (File menu, Open), as we have
seen in the previous lessons, or use the “local input” of each
function, which is more simple and only asks for the necessary in-
formation. 

• In the local data input window that appears, verify that the data
of Catherine Deneuve’s chart are still those displayed for the Na-
tal chart on the left. If this is not so, do lesson 5 again in order to
select the right chart, or click at the top on the button Restore last
chart used if this is due to the automatic erasing of the natal chart
data.

• On the right side of the local input window, if you just finished the
previous lesson, part of the data of Yves Montand’s chart (coun-
try, city and year) are still displayed. We are going to change
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them.
• Click on the Country button (on the right side of the input win-

dow): the list of countries appears. Press “FRA” to go directly to
the countries beginning with these letters, and select FRANCE in
the list.

• When the list of the available cities is displayed, select PARIS 75.
The program will automatically update the latitude and longitude
displayed below.

• We now need to specify the year for which we want the SR: type
2011. The software will consequently calculate the Solar return
that goes from 22nd October 2011 to 22nd October 2012 (there
is no need to enter the hour: it is computed automatically). Now
click the OK button to exit the local data input and return to the
setting window of the function. 

• In this window, select “On 2 adjacent windows” in the display
choices, and aspects between “Solar Return & Solar Return”, and
click OK.

• On two windows, side by side, you will now see the Natal Chart
on the left and the Solar Return on the right (the precise SR date
and hour has been calculated and is displayed in the window). To
display the next Solar Return (assuming that the person will be at
the same location), you can just click on the Future button (Tools
window, Time group) or press the “+” key. To get the previous
SR, click Past or use the “-” key. You can also select the desired
year of SR when you are in the setup window of the function, us-
ing the buttons Previous Return and Next Return of the “Chart Data”
section.

• For all returns (solar, lunar and others), you must enter the de-
sired place and date of return in the “Level 2 Chart” section; then
the software will automatically calculate the exact date and hour
of the return. For the Transits and Directions, do the same: enter
the place and date in the “Level 2 Chart” section.

• Note that when you display a chart of the Returns menu, the date
stated in the Tools windows for the Level 2 will be automatically
changed to match the calculated time of the return chart. In the
previous example, for the SR of Catherine Deneuve, the date of
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the Level 2 chart will therefore be modified by 21.Oct.2011,
23:50, which corresponds to the exact time of its solar return for
2011. Tip: after displaying the SR, if you want to restore the
Level 2 chart with the actual computer date and time, just press
the H (capital letter) key after the chart is displayed.

2.10 LESSON 8 – Outer planet transits in motion
Note: This function is available only in Astro-PC and other larger Aureas
programs. Go to the next lesson if the Slow Moving Planets step by step
function is not available in your specialty program.

Display the transits step by step
Now, we are going to see an interesting function which allows us to
view the transiting planets in movement through the chart. 
On the top menu bar, select the Transits menu. Click on Slow mov-
ing planets step by step. 
The program displays the selection window which allows you to
choose the manner of displaying the transits in motion: either as a
single chart on the entire screen (full page) or superimposed as a
second chart on the Natal Chart, or other options in some cases.
Choose “Dual ring, Natal on inside” and “Natal & Slow moving
planets” aspects. The “Planets” section allows to select the planets
you want to have in the transit list. For our example, select Mars
through Pluto. 
To indicate the starting date for the transit calculation, you can use
the Change chart data button located at the top right, as we did in a
previous lesson. In this case, as this function does not need to state
the location, you will just have to input the desired date.
More simply, note that it is also possible to initialize the data of the
forecast chart (Level 2 chart) by clicking on the small button “R” lo-
cated to the right of the data of the slow moving planets chart (in the
“Chart Data” section). This button automatically sets up the data for
today at this time. (The time is extracted from your Windows system com-
puter clock. If it is not accurate, you need to re-set your computer clock by
double-clicking on the time at the bottom right of your screen, and making
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adjustments in the window which displays).

Click now on OK. The Natal Chart is displayed in a smaller size, and
a second ring of transiting planets appears on the outside ring. They
will move around the Natal Chart with a speed that can be adjusted.
If a help window appears, you can close it.
• We are now going to make the transiting planets move with a

variable speed, either forward (future) or backward (past). The
speed rate is indicated in the Time group of the Tools window
(click on the tab of this group if necessary, or press Ctrl+1).
You can change the number of days to go forward or backward
in time by changing the value in the Tools window under “days:”.
If for example you want to trace the movement of Mars month by
month, type “30” for the number of “Chart days” of advance-
ment or reversal.

• There are two working modes for this function: Automatic or
Manual. You are in Manual mode when you ask for this function
(which is more practical when you want to take time to look at a
chart). To view the movement of transits every 10 days, press
now on the “+” key (or click the Future button of the Tools win-
dow, Time group). The chart will move 10 days ahead (you can
check it by looking at the date at the top of the chart display win-
dow). You can use the “-” key (or the Past button in the Tools
window) to go backward in time. You can use these keys or but-
tons as many times as you wish to repeat or reverse their func-
tions. 

• A table of the aspects between the two charts can be displayed by
clicking the DC/Nat button (Aspects group). These are the com-
parison aspects between the transiting planets and the Natal
chart. Spot the Slow Moving Planets – Aspect – Natal Chart title
at the top of the data window. It means that the planets in the left
column, under the Slow Moving Planets title, refer to the Level 2
Chart planets (transits), while the right column under Natal Chart
refers to the natal planets. This window can be moved anywhere on
the screen: to do so, you just have to click its title bar, and keep the
mouse button pressed down while dragging the window to the desired
place. You can close it with Ctrl+F4 or F12 or with the mouse.

• You can also view the aspects between a transiting planet and
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natal planets by clicking directly on the transiting planet. The as-
pect lines will appear in the center of the chart. If they do not ap-
pear, either there are no aspects (based upon the aspects you
have indicated to be used in the program) or you may sometimes
need to click on the Refresh button at the top of the Tools win-
dow to activate this function.

• For further information about this function, see the program’s
screen help.

2.11 LESSON 9 — Getting the exact transit dates
Note: Go to the next lesson if the Date Search Transit/Natal function is not
available in your software.

On the top menu bar, select the Transits menu, then the Date
Search Transit/Natal line.
The search window appears. Within the listing of the planets, select
those for which you want a date search by clicking them with the
mouse (if a check mark is at the left of the planet, it is selected). In-
put, for example, 6 months for the duration, select the major aspects
and “List (1 date)” for the display method, check the “Exact dates”
option, and select Mars to Pluto for the planets. Then click OK. The
transit dates will be displayed in a new window.
The two dates at the top of the window give the beginning date and
the end date of the search (depending on the search duration).
Then, the transits dates are listed, in chronological order, with the
transiting planets on the left and the natal planets on the right. For
example:

Plan.  Position Asp Plan.  Position  Date Natal
R  24°02’ D   0   P  24°02’ H  05.07.2002 22h56 (040y07m)

Q  00°00’ E   d   E  .  13.07.2002 15h23 (040y07m)

R  26°23’ D   "   S  26°23’ J  16.07.2002 10h58 (040y08m) !

S  24°09’ C   d   VI  .  25.07.2002 11h58 (040y08m)

V  14°54’ I   D  .  26.08.2002 11h00 (040y09m)

S  29°05’ C   R  .  11.10.2002 13h02 (040y10m)
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1) The first line indicates that transiting Jupiter, at 24°02 Cancer, forms a
trine to natal Venus (at 24°02 Scorpio) on 5 July 2002, when the native is
40 years and 7 months old.
2) On 13 July 2002, at 15h23, Mars enters Leo, in direct movement (and
otherwise an “r” would appear instead of “d” when a planet is re-entering a
sign via retrograde movement).
3) On 16 July, Jupiter is in opposition to natal Saturn. The last column, ti-
tled Natal, indicates if an aspect between these same two planets exists na-
tally (in the natal chart). In our example, there is a Jupiter-Saturn conjunc-
tion in the natal chart. To get this column, you must select the “Display the
Natal aspects” option in the Display tab of the Date search function window.
4) On the 25th, Saturn re-enters, by direct movement, into natal house VI.
5) On 26 August, Pluto changes from retrograde movement to direct move-
ment (D), at 14°54 Sagittarius.
6) On 11 October, Saturn goes Retrograde.

A number of choices are available for this function. The DATE
SEARCH window displayed after having chosen the search function
allows, among other things: • display the transits classified by planet
or date • display or not display the ingresses of transiting planets in
the signs, in the natal houses, as well as the retrograde ingresses •
select the aspects to take into consideration • choose the planets
and special points for which we want the transit dates • determine
the search duration • ask for the precise date of transit or take orbs
into consideration • choose the birth planets for which we want to
do the search, and other functions. See the on-screen help for fur-
ther information.

2.12 LESSON 10  —  Backup and Restore
Your personal chart files, as well as the astrological settings (options)
of the software, are stored on the hard drive of your computer. It is
strongly recommended to regularly back up these files, in case you
have a problem with your PC. This process also allows you to trans-
fer your personal files from a computer to another, for example if
you use your program on several PCs (with a USB security key).
These functions of Save and Restore data are available in the Help
menu of the software. For more information on how to proceed,
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click the Help button when you are in the settings window of the
“Save personal data” function. 

2.13 LESSON 11  —  Modifying the options
You can change an option by using the Options menu and selecting
the desired options group. Let’s suppose we want to display the five
main asteroids on our Natal chart:
• Display the Options menu by clicking on it. Select the Planets and

Special Points group.
• In the window, look for the “Chiron” line. There are two boxes to

its right: the first one allows us to display Chiron or not; the sec-
ond one allows us to view the aspects to this element or not. Click
on the first box: a check mark should display, indicating that this
element will be displayed on the chart. If you also want the as-
pects to Chiron, check the second box. 

• Do the same with Ceres and the other three asteroids. With As-
tro-PC, to display Juno, Pallas and Vesta, proceed as follows:
click below Ceres on the Haumea choice, in the window that ap-
pears, click on the right on the Juno choice (in the “Popular
choices” frame) and validate with OK. Proceed in the same way
for Pallas and Vesta by modifying Makemake and Eris.

• After you have made all your choices, click OK (*). The changes
will be taken into consideration and you’ll see the 5 asteroids in
your chart. (If they do not appear, display again the chart by
clicking on the Natal menu, Natal Chart line, then OK button).
(*) Note that instead of the OK button you can also use the Preview button
when you change options. In this case, the chart will be redrawn tempo-
rarily with the changes you have made. If they are right for you, click the
Validate choices button that appear at the top left of the chart. The other
two buttons allow you to return to the options to make further changes or
to cancel them.

• To cancel out the asteroids, do the same as above, but uncheck
the display boxes.

• If you use Astro-PC, all the yellow buttons in the “Planets and
Special Points” window are programmable points. If you click
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on them, you can chose to display many other elements (stars,
midpoints, arabic parts, asteroids, etc.). For more information,
click the Help button.

• For example, if you want to display a specific star on the charts,
click on one of the yellow buttons that you do not use, for exam-
ple “External Point 1”. The window that opens allows you to
specify what programmable point you want to display around the
chart. For example, if you want to display the star Antares, click
on the choice “Stars” to the left, then click in the yellow drop-
down menu below: select Antares from the list displayed. You
can give the abbreviation you want to this star, for example
“Ant”. Confirm with Ok: from now on, this star will be displayed
around the charts.

Another important example allowing you to modify the “Usual
place and time zone”: whenever you select a derived chart, such
as a Solar Return or a Transit chart, you simply enter the derived
chart location as that of the Level 2 Chart in the Data Input Win-
dow.
By default, the program indicates “USA California” and “Los Ange-
les”. If you want the default location to be where you live, click on
the Options menu and select the line Default Location and Local
Time Zone.
In the window that then appears, click on the Country button and se-
lect from the countries and states listed. Then choose the city you
want. Next, click on the OK button. From that point onward, the
city appearing by default for the Level 2 Chart will be the one you
just selected (as well as when you create new charts).

Setting the variable option is one of the first procedures you will
want to implement so that the program will be suited to your cus-
tomary usage. Use the choice Colors in the Options menu to suit
the colors of the various chart components to your preferences. The
choice Aspects and Orbs will allow you to indicate the aspects you
wish to use in your charts, and their orbs, as well as other options.
When you modify the options and click on the OK button, the chart

44  — Chapter 2: Tutorial



is displayed again on the screen in order to see your new modifica-
tions. The changes are automatically saved to your hard disk. If you
exit the program and return later, you will find you new choices in
effect.

Another example (available in Astro-PC only): choice of chart
displayed when the program is started up. When you start up
the program a chart may be displayed automatically in the chart dis-
play window. You can choose this via the option Options–Startup
displays. If you for example want to see the chart of the current mo-
ment each time you start the program, click the following options:
At program startup: Draw the chart “Level2”, then / For “Natal”
data use: last calculated chart / For the “Level2” data, use: chart of
the day.

The Option Files (available in Astro-PC only)
With Astro-PC, you can create up to 11 standard configuration for-
mats, and then at any moment automatically re-display a chart in
any one of these formats upon re-selecting your personal Option File
format.
Here’s an example: let’s say you want to see the charts on the
screen with light colors, but prefer to print the charts in darker col-
ors. To do this, create an option file with light colors; to know how
to do this, click on the menu items Options, position the mouse on
the line New option file until it is highlighted, and then press the F1
key:  you will obtain a help screen describing this function. 
Name the new Option File “Light Colors”. Then go to the menu
item Options–Color Choices to select the color you want displayed
on the screen. If you need help with this, click on the Help button in
the option window displayed. 
Now create your second Option File: again use the menu item Op-
tions–New option file, and create another file to be called “Dark Col-
ors”. Then, return to the menu item Options–Color Choices, and
specify the dark colors you want.
Next, display a natal chart on the screen. Now you can right-click
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on any blank area surrounding the chart, and trigger a contextual
menu. In the contextual menu you should now see the options “Re-
fresh Light Colors” and “Refresh Dark Colors”. If you click on the
first option, the natal chart will be displayed in light colors. If you
want to print however in dark colors, select “Refresh Dark Colors”,
and then proceed with the Files–Print function. 
You can create files for a wide range of possible options. Via conve-
nient use of the mouse, your charts will be immediately re-displayed
in the format of your choice. You can thus, for example, see your
charts quickly and alternately with or without asteroids, in tropical or
sidereal zodiac, in 90-dial format or 360-dial format, with different
orbs, or still other options.

2.14 LESSON 12  —  Buttons of the sidebands
Two sidebands located at left and right of the screen offer additional
buttons to access more quickly and easily to the different software
functions. This is very useful for example with touch screens. These
sidebands can be activated or deactivated via the Options menu, In-
terface preconfiguration choice.

The screen tiles (left sideband)
When you start the program, if the left sideband is activated, a win-
dow with large colored buttons appears automatically. It offers to
obtain the desired charts in a way other than with the top menu bar.
For example, clicking (or pressing) the “Natal Chart” button, you
will get a new simplified setup window: by clicking the “Full Page”
button, the chart will be displayed on the screen.
To view again this screen of colored buttons, just move the mouse
(or finger) on the left side of the screen where the colored sideband
is. With the keyboard, you can also activate it by using the “left ar-
row” key, or the “<” key.
If you click the “Natal Chart” button while holding the Shift key
pressed, it is the classic and full setup window (with a grey back-
ground) that will be proposed. Finally, if you hold down the Ctrl
key while clicking the button, you get directly the desired chart, with-
out any setup window, but in this case the chart is displayed by de-
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fault with a “full page” presentation.
Depending on the software you have and the size of your screen,
the buttons displayed on the right may not be all visible. In this case,
you can scroll the window to the right or to the left. To do this using
the mouse, just click on the bottom of the screen in an empty area,
keep the mouse button pressed, make a move to the left or to the
right, then release the mouse. With a touch screen, touch and drag
your finger in the desired direction.
Clicking with the right mouse button on the left sideband, you will
get a small menu that allows you to set the colors of the buttons,
their classification, their mode of operation, etc. If this screen of but-
tons is not useful to you, you can deactivate it (or reactivate it) using
the Options menu, Interface preconfiguration choice.
For more information on these buttons, see the on-screen help of
the software. You can also point the mouse on the “Help for but-
tons” button to get some basic information.

The buttons of function for the charts (right sideband)
When an astrological chart is displayed on the screen, you can get
much more information using the buttons of the Tools window on
the left side of the screen.
If the right sideband has been activated in the Interface preconfigu-
ration, the gray sidebar on the right of the screen allows you to ac-
cess to the functions of most of the Tools window buttons in an
other way, with a display directly around the astrological chart. For
example, when a Natal chart is displayed on the screen, if you move
the mouse (or finger) to the right of the screen, several buttons will
appear around the chart. You can then simply click on one of them
to get the desired data. (Note that if you simply move the mouse
over a button, without clicking, a small line summarizes the informa-
tion it will display).
With the keyboard, you can also get the display of these buttons us-
ing the “right arrow” key, or the “>” key. By clicking on the right
sidebar with the right mouse button, you can access a small menu to
perform various actions and settings. You will find a choice to dis-
able this sidebar if you do not want to use it (you can also do it us-
ing the Options menu, Interface preconfiguration choice). For more
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information about the other possibilities, see the on-screen help.

2.15 LESSON 13  —  Specific Graphic Options
Several astrological fonts are available in our software and allow to
display the charts and data tables with different symbols. You can
preview them by clicking on the Options menu and selecting the
Sign and Planet Symbols choice.
With Astro-PC, by clicking at the top right on the “Zodiac signs” tab,
you will see that the signs can be displayed with five different sym-
bol collections. By default, when you install the software, it is the
classic astrological font that is active, but you can just check another
choice if you prefer.
Always with Astro-PC, you can also temporarily change the display
of symbols using the Aureas logo displayed at the top right of the as-
trological charts. By clicking on the logo, the signs and planets of the
chart on the screen will be displayed alternately with the different
fonts available in the software.
If you right-click on this logo, you will see a contextual menu that al-
lows you to make other choices: change only the symbols of signs or
planets among all available choices, or also test other chart styles
display. These changes are temporary: the chart will be redisplayed
in the usual way for the next charts. If you want to change the font
symbols or the chart style permanently, use the Options menu at the
top of the screen.
In most of our programs, the Aureas logo is also available in the
data windows and offers other possibilities. For example, after dis-
playing a Natal chart on the screen, if you click on the “PHPos.” but-
ton in the Tools window (or type the capital letter N on your key-
board), you will notice the Aureas logo at the top right of the data
table. By clicking on this logo, the data can be displayed in three dif-
ferent ways: using the Aureas12 astrological font symbols, with the
AureasA font symbols (alternative font with more asteroid glyphs),
or just in text mode. With each click, you will switch from one to the
other. Or you can also right-click on the logo and select the desired
choice from the drop-down menu.
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The Aureas logo allowing different actions is also available in other
places. For example, if you are using Astro-PC and the Tools win-
dow format #2, clicking the logo at the top right of the tools window
will change the button colors. Also, when you are in the chart data
input window, the Aureas logo allows you to change the colors of
the window.

The lessons are finished. Now, we recommend that you study the
specifics of the program by looking at the screen help. We’ll see how
to do this in the next chapter. 
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3.1   SCREEN HELP
Our programs possesses a highly useful integrated screen help func-
tion, available at any moment by several methods.
This help is provided in two formats: a classic and practical display,
using files in “.hlp” format, and another form a little less aesthetic,
but compatible with the latest versions of Windows, in “.chm” for-
mat. The choice between one or the other format is done by going
in the Options menu, Advanced users choice. In the “On-screen
Help files format” section, check the desired choice.
By default, when you install the software, it is the compiled format
that is proposed, but we recommend that you install the “.hlp” help
viewer for a more pleasant and aesthetic access to the help-screen.
For this, you still need to use a special program called Windows
Help. You can download this software with the help files using this
link :   https://www.aureas.eu/Textes/WinHelp32AutonomeUS.zip
After downloading this compressed file, right-click on it and Extract
the files for example on your Desktop. In the “AureasHelpFiles”
folder that will be created, you will find the three help files with the
“.hlp” format and the WinHelp program. To view any of the help
file, click on it, hold down the mouse button and drag it onto the
WinHlp32 program: this will display the contents of the on-screen
help file with all its features, as explained below in this chapter.
Note also that a PDF file containing all the information of the main
help file is also available through the Help menu of the program,
Display the main help file choice. 

Note: if you are using Windows 8, 7 or Vista (but not Windows 10 and 11),
you can also download and install Windows Help on the Microsoft website.
For instructions, click the Help menu in your software, select Technical In-
formation and then the line Download Windows Help. This will display the
Microsoft web page where you can download the program “Windows Help”
(WinHlp32.exe file). After installing it, you will have access to the on-screen
help of our program with all its features, as explained in this chapter.

Help buttons:
You already saw the help available through certain buttons, such as
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in the d ata input window where the Help and DST help buttons will
give you a lot of information if you’ll just click on them.
In other windows, like the options windows, the Help button will be
there at any moment you need it in order to guide you through how
to use the program.

F1 key: 
The F1 function key will also allow you to get help concerning the
last executed function, a specific option, a command in the tools
window, or other specific functions, at any point in the program.
1) After a function of a menu : If you just asked for a chart dis-
play, for instance of a Natal Chart, you simply press the F1 key im-
mediately afterward, and the program will display help concerning
the function you just selected.
2) In an option window : When you are in an option window and
you want to get information about one of the options, go to that op-
tion line with the mouse or the keyboard and then press F1: you’ll
get the help corresponding to that option.
3) In the Tools window : Within the tools window, you can ask
for the help anywhere in the window by pressing F1 after having se-
lected a button or a command.

General Help
The access to screen help as we just saw it above displays the help
specific to the desired item.
You can also use the screen help in a general way, by going to its
first page and then by studying the different chapters (topics) pro-
posed. To do so, select the Help Contents function of the Help
menu (F11).

How to use the help
The upper part of the help screen consists of a menu bar, allowing
you to access a number of functions. Below that bar, command but-
tons allow to take specific actions. 
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For instance, to go to the very beginning of the help text, click the
Contents button located at the top left of the help screen. 
The most-used functions are those of the Options menu and of the
direct access menus to the help topics.
Following are descriptions of what the buttons do:
Contents button: This button will always take you back to the
home page of the help screens, wherever you are.

Search button: This button gives you access to a very practical
tool for the help screens: the key-word search. A large number of
subjects are sorted alphabetically, and you can make your choice by
moving through the list with the scroll bars, or by typing a word di-
rectly in the box. A simple double-click on the chart you are inter-
ested in will take you to the desired topic.

Back button: When you move from one screen to the next, going
from one topic to another (and possibly from one file to another),
you click one of the proposed choices (printed in color characters)
each time. The Back button allows you to go back to the previous
topic each time you click on it.

Print button: This button allows you to print out the contents of
the displayed topic on paper. 

Glossary button: For those new to computers, the Glossary de-
fines some commonly used computer terms.

Help button: Allows you to go to the summary of general help
available for your astrological program (see below).

DST Help button: This button allows you to go to supplementary
information on general use of Summer Time and Daylight Saving
Time (DST) in countries and states around the world. For very com-
plex situations, you may be referred to outside references.

Tech. Help button: This button displays the technical help and its
different topics (see below).

<< and >> buttons: When these are accessible (not shaded),
these buttons allow you to scroll backward and forward through the
help screens horizontally (for data within related topics) (rather than
vertically, i.e. hierarchically, or from one general category to the
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next). In essence, this means these buttons help you quickly move to
other screens on closely related topics. To illustrate their usefulness,
let’s say you are looking at the American states in the Summer Time
(DST) help file, and you want to go to the previous state or the next
state: you can press the appropriate button to scroll either to the
previous state, or the next state, one by one.

Topic lines: In most of the screens, you will see words or sentences
in underlined and in bold color characters. These take you to chap-
ters, paragraphs, or topics that you can reach directly by simply
clicking on them. The on-screen help is introduced in hierarchically,
which means that the first page of the screen gives a summary of the
chapters, and they in turn give you access to sub-chapters. You can
move as you want around the help screens, following the proposed
structure, or by using the Search function or the >> and << but-
tons.

Size of characters on screen: You can reduce or enlarge the
help screen print. If you cannot easily see what is displayed, use the
Options menu of the help file, Fonts function, and Large choice.

Help files
The program contains three help files: a main help file explaining all
the capabilities of the software, a help file for Summer Time (DST)
and time zones, and a third one for technical help. You can identify
in which help file you are at the moment just by looking at the first
line of the screen. You can go from one file to another by clicking
on Help, Tech. help, or DST help, or via the bold color text links within
the text displayed below the menu.

How to leave Screen help
To leave the on-screen help and go back to the program functions,
you can press the Esc key, or else the Alt+F4 keys simultaneously.

We recommend that you make yourself familiar with the use of the
help files, because you may frequently need them. And this will
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save you a tremendous amount of time later on.
Now, click the Contents button in order to go to the home page of
the on-screen help and study the different chapters.

Printed help files
If you want to print the main help file on paper, you can do so by
opening the Help.pdf file: Help menu of the program, Display the
main help file choice.

Tips on startup
Each time you start the software, you can ask to see on the screen a
tip or advice on how to use the program. To do this, select the Help
menu, Tip of the day, and check the option line “View the tip screen
at startup”.

Contextual information
When you move the mouse over some items, such as buttons, a
small yellow line will tell you the meaning of the element concerned.

Keyboard shortcuts
Our programs offer many keyboard shortcuts to get the desired in-
formation faster. For example, to display a Natal Chart, you just
have to type on the letter n (lowercase) on the keyboard. A sum-
mary of all keyboard shortcuts is available via the Help menu, Tech-
nical information, Help about the functions accessible with the key-
board (or type the ? key).

3.2 HOW TO DO TO  ...

A special tip file, available directly from the software, will show you,
classified by field, the sequence of commands to enter if you want to
change options or input choices. You can access it with the Help
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menu of your program, then selecting How to…
Warning: depending on the version of the astrological software that
you own, some sequences may not be available.

3.3 SOFTWARE ACCURACY

You will find in the Help menu, selecting Technical information, and
Software accuracy, an information file on this subject, as well as how
to use dates before 1600 (Gregorian and Julian calendars). The ac-
curacy level is among the highest among astrological programs.

3.4 WARRANTY

SOFTWARE: 
Aureas liability concerning this software is limited to normal use. The
buyer is liable for his or her use outside our recommended condi-
tions and for the possible consequences coming from it, as the Au-
reas company cannot be held responsible for resulting damage.

Two modes of delivery are available:
• Download of the program on our website. 

AUREAS ensures the availability of the downloaded software on
his website for a minimum of 4 years. We recommend that you
perform immediately a backup copy of the downloaded software
(on a CD-ROM or other support).

• CD-ROM delivered by mail. 
AUREAS will exchange all defective program CDs during a period
of 2 weeks following your purchase of the product (as verified by
documentation). After this period, you will be able to download
the software (see above paragraph) on our website. In other
cases, if you ask Aureas to send you a new CD, this service will
be charged (contact us to know the price).
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SECURITY: 
It is inseparable from the software. There are two types of protection
(see page 7 of this manual):

• Security protection on the hard disk: If your software was pro-
vided with the usual security protection on the hard disk, Aureas
will provide after-sales assistance necessary for the installation of
the security protection for at least four years. This service is free
of charge, but limited to 3 reinstallations by year. If you need
more, any additional reinstallation will be charged 10 €. If pro-
vided with a security protection on the hard disk, the purchase of
the software represents the purchase of the right of use for a sin-
gle computer. If you want to use the program on a second com-
puter, there is an additional cost indicated on our website.

• Security protection with a special USB key: The USB security key
functions as the license for your program, so be very careful to
not lose it, as you will otherwise need to pay the cost of a new
program to continue. Note that we no longer sell USB security
keys due to operating problems with the latest versions of Win-
dows. If you have an old USB protection system and have a
problem with it, you may have to switch to the “security protec-
tion on the hard disk” (see above).

Caution: if you have an old security key, in case of theft or loss the re-
placement of the key by the usual protection system will be charged 70%
of the price of the software. So take good care of it! Some tips: attach a
cord to the key to see it better; tell your family that is it not a memory key
but a specific protection for your software. (If you use the program on a
maximum of two computers, it is better to switch to the protection system
on the hard drive (see above), as the license is then managed by Aureas
at each installation, and there is consequently no risk of theft or loss.)

3.5 GLOSSARY of a few basic computer
terms for the new computer users

Astrological function: This is a process such as drawing a chart or a
creating a list of data from a chart. Functions are available through the
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main menu bar in the Tools window.
Button: Buttons in the program function like buttons on electrical equip-
ment. By clicking on them with your mouse (i.e. “pressing” them), or se-
lecting them via the keys (Tab, Arrow, and Spacebar keys) they auto-
matically perform functions such as creating and displaying tables, open-
ing data windows, or redrawing charts. Most often they appear as a rec-
tangle with a name in the center that describes their function. Some ex-
amples of command buttons in the Data Input window are OK, Cancel,
Help. (These differ from “Radio Buttons”, which are used for selecting
options from a list.)
Click: Clicking the mouse means you press one of the buttons on the
mouse with your finger (usually after moving it to the function you want
to perform). In the majority of cases, and where left-click or right-click is
not indicated, you press the left-hand button (in the other cases, “right-
click” is noted.)
Confirming: Confirming means that you press the Enter key or click a
button (including the OK button) after inputting data, or after pressing an-
other function button. This action will end a data input process, or will im-
plement the actual function of another button selected.
Desktop: The desktop is the screen which displays right after you first
turn your computer, before any of your programs are started. It contains
several icons: one for most every program you have added to your com-
puter, as well as one for the Recycle Bin, etc. A double-click on one of
these icons will either open it or automatically start its functions.
Double-click:  To click twice quickly on any item on your screen.
Drag and drop: To click on a moveable item (usually a window) and
while keeping the mouse button depressed, move the item by moving
the mouse. Once at the new desired position, you “drop” the item (usu-
ally a window) by releasing the mouse button.
Explorer: This is the generic Microsoft computer system program allow-
ing you to make copies of floppy disks and files, removals, and classifi-
cations, and to view the directory contents of your computer files.
External point: This is an extra astrological point you enter manually,
that is not calculated automatically by the program. It could be a planet
from another chart, a geographic factor measured via the zodiac, or an-
other experimental factor you want to investigate. The program will dis-
play the position in your charts and will calculate its aspects along with
the rest of the chart factors.  It is also referred to as an “Extra Point”.
Icon:  This is a small picture that functions like a button (see Button).
Menu bar: This is the line of words displayed at the top of the screen.
It categorizes most all the functions of a program, and by activating the
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category words on the menu, you will usually then see a list (menu) of
functions within that specific category... and you can then choose the de-
sired function from the list. The Main Menu bar remains at the top of the
main window for as long as the program runs (except when charts are
magnified via the zoom function). Sometimes, there are also supple-
mentary menu bars inside new windows opened.
Menu: A menu is a list of functions gathered under the same category.
To view the list/menu, just activate its category name by clicking on it, or
by holding down the Alt key while you type the underlined letter in the
category name you want.
Point: To point the mouse consists of moving the mouse so that pointer
(the arrow) is within any button, word, or icon you want to select, open,
or view textual information about.
Programmable Point: available with Astro-PC, this is a modifiable point
of your choice or making that you can display in the charts.
Radio Buttons: These are circles next to items in a list, indicating that
you can choose any one of the listed items. If the circle is empty, the
item is not selected. If the circle however has a black dot in the center,
the function or factors whose name follows it has been selected to oper-
ate.
Scroll bar and buttons: This is are a thin, shaded area located on the
right side and at the bottom of the data windows. Each scroll bar con-
tains a little square called a scroll button, as well as two arrows at each
end. The scroll button tells you where you are in the list of data displayed
in the window, and moves you up and down the page. If it is at the top,
it means that the lines displayed in the window are those of beginning of
data. If it is at the bottom, you are at the bottom of the data list.
Select: This literally means to choose something. It usually consists of
clicking on any desired button, icon, or word. The selected item will then
be highlighted for contrast, to show that it has been selected. By clicking
one more time, or by pressing the Enter key, the desired action is per-
formed. You can also “select” text by positioning the mouse at the begin-
ning of the desired word or phrase/s, and then clicking and dragging to
the end of the text, where you release the mouse button.
Sensitive point: A sensitive point is an empty degree of the zodiac
which potentially forms an aspect or midpoint with a planet or point al-
ready in the chart.
Shortcut: A shortcut is a copy of the icon or button that activates a pro-
gram. The shortcut icon can be placed anywhere (for instance on the
Desktop) and automatically open the file or the program it is linked to.
Your Windows help sources will explain how to create shortcuts.
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Special points: Special points include astrological factors which are
technically not classed as “planets”, but which are important for the as-
trologer. These potentially include Ascendant, the Midheaven, the Lunar
Nodes, the Black Moon, the Part of Fortune, and other factors.
Tab: This word has two meaning in the computer context. There is a
Tab key which moves one around the screen or indents a paragraph.
Then, there is also the Tab which emulates the Tab of a file folder: it
may be selected to open up, for viewing, the information inside a set of
stacked “folders”. In the Aureas programs, you find such Tabs in the
Tools window.
Title bar: The title bar is the text that appears at the very top of a win-
dow, and it reminds you of the contents of the window.
Validate: Validating consists of pressing the Enter key or clicking on a
button after selecting or inputting data, thus confirming the typed data or
the desired function.
Window: A window is a frame in which text or pictures display. For
Astro-PC charts, you can open several graphic windows in which you
can view several astrological functions. For instance, one window might
contain the natal chart of a person, while another window contains the
natal chart of a second person; and a third window might even contain
the midpoints between these two charts. Windows called “data windows”
will appear when you ask for special functions activated by the buttons in
the Tools window. A window includes a title bar, and a window
containing more data than can be displayed on the screen include a
scroll bar (see these words for definitions).
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